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CHAPTER 6 CONDITIONAL FORMATTING 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Formatting allows you to change the way that the data in cells in a 
worksheet appear on the screen. For example, numbers can be 
made to appear as currency values or percentages by formatting 
them accordingly. 

Microsoft Excel 2010 provides a variation on formatting known as 
conditional formatting. With conditional formatting, cells can be 
formatted in different colours schemes. Rather than this formatting 
being applied to all cells in a range, it is applied selectively and 
based on specific rules. This type of formatting allows you to see, 
for example, values that are over a certain amount, or to instantly 
spot high and low values based on assigned colouring. 

In this session you will: 

 gain an understanding of conditional formatting 

 learn how to conditionally format cells containing specific 
values 

 learn how to clear conditional formatting 

 learn how to use more of the cell formatting options 

 learn how to format the top ten items in a range 

 learn how to use the various Top/Bottom Rules 

 learn how to work with data bars 

 learn how to work with colour scales when formatting 
conditionally 

 learn how to apply icon sets to conditionally format a 
range 

 gain an understanding of Sparklines 

 learn how to create Sparklines 

 learn how to edit Sparklines. 

INFOCUS 
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UNDERSTANDING CONDITIONAL FORMATTING 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 

As the name suggests, conditional formatting 
is a type of formatting that is applied to cells or 
ranges when certain conditions are met. These 
conditions are set, but can quite often be 

customised and edited, in rules that have been 
programmed into Excel. There are two types of 
conditional formatting – values-based formatting, 
and trend-based formatting. 

What Happens With Conditional Formatting 

With conditional formatting, cells in a specified range are coloured or shaded according to certain 
conditions which are outlined in rules. 

Values-Based Conditional Formatting 

With values-based conditional formatting, cells in the range are examined and their shading and 
colouring is based on whether they meet the conditions of the rule. This type of formatting allows you 
to see whether values in a range are greater than a certain value, less than a certain value, equal 
a certain value, or fall between a range. You can also display top ten, bottom ten, top 10%, bottom 
10%, and above and below averages with this type of formatting. 

In all cases a dialog box will appear which will allow you to tweak the rule to what is needed. 
Basically, the dialog box will allow you to specify a rules value and to determine the colour of the 
shading. A dialog box for the between value appears as follows: 

2 Trend-Based Conditional Formatting 

With trend-based conditional formatting, colouring is applied to all of the cells in the range. The 
depth of the colouring is determined by the values shown in each cell relative to the overall total of 
the range. This allows you to instantly spot higher, lower, and median values in the range and to see 
the trend of the numbers. The formatting can be applied in the form of coloured bars, coloured 
scales, and even icons. An example of all of these is shown below: 
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FORMATTING CELLS CONTAINING VALUES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Before starting this exercise 
you MUST open the file 
E821 Conditional 
Formatting_1.xlsx... 

 Select the range I4:I45 

 Click on the Conditional 

Formatting tool  in the 

Styles group on the Home 
tab of the Ribbon, then 
move the mouse pointer 
over Highlight Cells Rules 
to see the options 

 Click on Greater Than to 
see the Greater Than 
dialog box 

 With Live Preview, the cells 
in the range that meet the 
condition are highlighted… 

 Type 90000 and watch how 
the formatting changes 

 Click on the drop arrow  

for With and click on Green 
Fill with Dark Green Text 
to change the colouring 

 Click on [OK] to complete 
the formatting 

 Click on A1 to deselect the 
range and see the 
formatting more clearly 

 

For Your Reference… 

To format cells containing specific values: 

1. Select the range 

2. Click on the Conditional Formatting tool 

 and select Highlight Cells Rules > 

[option] 

Handy to Know… 

 The Greater Than conditional formatting 
option is very literal. If you ask it to format 
values over 90,000 for example, it will only 
format values that are over 90,000 – any 
value of 90,000 will not be formatted. 

2 

5 

A common analysis requirement is to see which 
values in a worksheet are greater than a specific 
amount. For example, if you want to see which 
salespeople have bettered their targets. This can 

be done using the Greater Than option which 
appears as one of the options in the Highlight 
Cells Rules set of the Conditional Formatting 
command. 
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CLEARING CONDITIONAL FORMATTING 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Continue using the 

previous file with this 
exercise, or open the file 
E821 Conditional 
Formatting_2.xlsx... 

 Click on the Conditional 

Formatting tool  in 

the Styles group on the 
Home tab of the Ribbon 

 Move the mouse pointer 
over Clear Rules to see 
the options available 

 Click on Clear Rules 
from Entire Sheet to 
clear all of the formatting 
from the entire worksheet 

 

For Your Reference… 

To clear conditional formatting: 

1. Click on the Conditional Formatting tool 

 

2. Move the mouse pointer over Clear Rules 
and click on Clear Rules from Entire Sheet 

Handy to Know… 

 You can also clear the conditional formatting 
for a selected range. This will be useful when 
you have conditional formatting in some 
places in the worksheet that you wish to 
keep. 

2 

3 

Excel will compound conditional formats. For 
example you can apply a Greater Than format, 
then come back and apply a Less Than format. 
The original format will remain, depending upon 

what is required in the second format. Unless you 
want compounding formats, it is much safer to 
clear any previous formats from the worksheet 
before applying a new one. 
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MORE CELL FORMATTING OPTIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Continue using the 

previous file with this 
exercise, or open the file 
E821 Conditional 
Formatting_3.xlsx... 

 Select the range C4:H10 
which includes all of the 
sales for BMW motor 
vehicles 

 Click on the Conditional 

Formatting tool , 

click on Highlight Cells 
Rules then click on Less 
than to display the Less 
Than dialog box 

 Type 15000 to see how 
many months had model 
sales less than 15,000 

 At this stage we want to 
use more of these 
commands so we’ll cancel 
from the previous one… 

 Click on [Cancel] to 
cancel the formatting 

 Repeat the above steps 
and try the Between 
setting and the Equal to 
setting as shown 

 Click on [Cancel] to 
cancel the formatting 

 

For Your Reference… 

To format cells containing specific values: 

1. Select the range 

2. Click on the Conditional Formatting tool 

 and select Highlight Cells Rules > 

[option] 

Handy to Know… 

 When applying conditional formatting, if you 
inadvertently click on [OK] instead of 
[Cancel], you can either use the Clear 
Rules option or the Undo operation in Excel 
to remove the unwanted formatting. 

1 

3 

There are a number of options under Highlight 
Cells Rules in the Conditional Formatting tool 
that are handy to know and use. These include 
the ability to format less than (in addition to 

greater than), to format for values between two 
values, and to format for values equal to a specific 
value. 

5 
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TOP TEN ITEMS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file E821 Conditional 
Formatting_4.xlsx... 

 Select the range C4:H10 

 Click on the Conditional 

Formatting command  in 

the Styles grouping on the 
Home tab of the Ribbon. 
Move the mouse pointer over 
Top/Bottom Rules to see the 
options available 

 Click on Top 10 Items to see 
the Top 10 Items dialog box – 
the top 10 items in the range 
will now be coloured 

 Click on the down arrow next 
to the quantity until only 5 
appears – the top 5 items in 
the range should now be 
coloured 

 Click on [OK] to apply the 
formatting 

 Click on A1 to see the 
changes more clearly 

 

For Your Reference… 

To format the top <n> items: 

1. Select the range 

2. Click on the Conditional Formatting tool 

 and select Top/Bottom Rules > Top 

10 Items 

Handy to Know… 

 Don’t confuse the Top 10 Items with Top 
10% - one displays only 10 results while the 
other can display a variable amount of 
results based on what fits into the top 10 per 
cent of a category. 

2 

3 

Conditional formatting can be used in a 
worksheet to highlight upper and lower values. 
For example, it is often interesting to know your 
top 10 customers, or the top 10% of products 

sold in the last year. This can be achieved using 
the Top/Bottom Rules of the Conditional 

Formatting command. 

6 
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MORE TOP AND BOTTOM FORMATTING OPTIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Continue using the 

previous file with this 
exercise, or open the file 
E821 Conditional 
Formatting_5.xlsx... 

 Select the range C4:H10 
which includes all of the 
sales for BMW motor 
vehicles 

 Click on the Conditional 
Formatting command 

, click on Top/Bottom 

Rules then click on Top 
10% to display the Top 
10% dialog box 

 Spend a few moments 
studying the results, then 
click on [Cancel] to clear 
any formatting 

 Repeat steps 2 & 3 and try 
the Bottom 10 Items, 
Bottom 10%, Above 
Average, and Below 
Average options as shown 

 

For Your Reference… 

Formatting cells for top or bottom: 

1. Select the range 

2. Click on the Conditional Formatting tool 

 and select Top/Bottom Rules > 

[option] 

Handy to Know… 

 Remember, the spinner arrows (the up and 
down arrows) next to the values in the 
conditional formatting dialog boxes allow you 
to refine your conditional formatting for the 
number of items and the percentage of 
items. 

2 

4 

The Top/Bottom Rules option in the 
Conditional Formatting command provides a 
number of useful options for displaying upper and 
lower ranges in your data. You can display the 

top and bottom <n> number of values, the top and 
bottom percentage, and whether values are above 
or below average. 
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WORKING WITH DATA BARS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Before starting this 
exercise you MUST open 
the file E821 Conditional 
Formatting_6.xlsx... 

 Select the range C11:H11 
– this range represents 
the total monthly sales of 
BMW vehicles 

 Click on the Conditional 

Formatting tool  in 

the Styles group on the 
Home tab of the Ribbon, 
then move the mouse 
pointer over Data Bars to 
see the options available 

 Move the mouse pointer 
across the colours and 
notice how coloured bars 
appear across the range 

 Click on Orange Data Bar 
in Gradient Fill, then click 
on A1 to deselect the 
range 

 The bars indicate the size 
of each value relative to 
the total 

 

For Your Reference… 

Using data bars to highlight values: 

1. Select the range 

2. Click on the Conditional Formatting tool 

 and select Data Bars > [colour 

option] 

Handy to Know… 

 To change to a different Data Bar colour, run 
the Conditional Formatting command 
again, however ensure that the range 
selected is exactly as it was when originally 
created. 

1 

2 

It is sometimes tricky to spot patterns or trends 
when confronted with a worksheet full of figures. 
Conditional formatting allows you to colour 
cells so that you can see how the figures move 

from high value to low value. Data bars provide 
colour accents to cells in the selected range. The 
width of the accents depends on the data value and 
its relation to the overall total. 

4 
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WORKING WITH COLOUR SCALES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E821 Conditional 
Formatting_7.xlsx... 

 Select the range C4:H4 – the 
vehicle monthly sales for the 3 
Series BMW vehicles 

 Click on the Conditional 

Formatting tool , then 

move the mouse pointer over 
Colour Scales to see the 
options available 

 Move the mouse pointer 
across the colours and notice 
how coloured shading 
appears across the selected 
range 

 Click on Green-Yellow-Red 
Colour Scale 

 Select the range C7:H8 – the 
vehicle monthly sales for the 
X Series BMW 

 Click on the Conditional 

Formatting tool , click on 

Colour Scales, then click on 
Green-Yellow-Red Colour 
Scale to apply the shading 

 Click on A1 to deselect the 
range and get a better view of 
the colouring 

 

For Your Reference… 

Using colour scales to highlight values: 

1. Select the range 

2. Click on the Conditional Formatting tool 

 and select Colour Scales > [colour 

option] 

Handy to Know… 

 With a 3 colour option Excel divides the 
values according to the number of cells in the 
range and then applies a scale of hues. The 
first colour (Green above) is applied to the 
highest value, while the last colour (Red 
above) is applied to the lowest. 

1 

2 

Colour scales are a part of conditional formatting. 
Instead of only part of a cell being coloured, with 
Colour Scales the entire cell is shaded a colour. 
The colours throughout the selection however 

adopt a different hue and intensity dependent upon 
the value in the cell relative to the overall selection 
total. When applied, graduated colouring appears 
across the range. 

7 
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WORKING WITH ICON SETS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Continue using the 

previous file with this 
exercise, or open the file 
E821 Conditional 
Formatting_8.xlsx... 

 Select the range I4:I10 – 
the total vehicle monthly 
sales for BMW vehicles 

 Click on the Conditional 

Formatting tool , 

then click on Icon Sets 
to see the sets available 

 Move the mouse pointer 
across the icons and 
notice how the icons 
appear in the selected 
range 

 Click on the 3 Symbols 
(Uncircled) option, in 
Indicators 

 Click on A1 to see the 
effect more clearly 

 

For Your Reference… 

Using icon sets to highlight values: 

1. Select the range 

2. Click on the Conditional Formatting tool 

 and select Icon Sets > [icon set] 

Handy to Know… 

 Using the 3 Symbols (Uncircled) conditional 
formatting option, there are 3 icons which are 
applied according to the rule of thirds in the 
range. Values that fall within the top third 
receive the tick icon, values in the second 
third receive the exclamation mark, and the 
values in the last third receive the cross. 

1 

2 

Using colours to conditionally format ranges in a 
worksheet is fine providing that your readers are 
capable of interpreting and indeed even seeing 
colours. In lieu of colouring a conditionally 

formatted range you can apply icons to the range. 
With Icons a symbol is placed next to a cell to 
indicate the position of that value relative to the 
range total. 

5 
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UNDERSTANDING SPARKLINES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

What do you get when you cross charts with cell 
formatting? Sparklines! Sparklines are a new 
feature in Excel 2010. They are like mini-charts 
that are actually placed into a single cell and can 

be used to represent trends and patterns in the 
data in a worksheet. They are accessed from the 

Insert tab of the Ribbon. 

What Are Sparklines? 

Sparklines are simply mini-charts embedded into a single cell.  

 

Line Sparkline 

Column Sparkline 

Win/Loss Sparkline 

Each of the Sparklines above charts the figures for the Jan, Feb, and Mar columns to their left. For 
example, the Sparkline in cell G4 charts the figures in the range C4:E4. 

There are three different types of Sparklines available in Excel 2010, Line, Column, and Win/Loss. 
Each of these are shown above. The Line Sparkline displays as a line. The dots in the example 
above appear because the Sparklines have been asked to display the highest and lowest values. A 
Column Sparkline displays as vertical bars. The Win/Loss Sparkline displays positive values in 
one colour above an imaginary line and negative values in another colour below that imaginary line. 

While Sparklines are never going to be as versatile as charts there are still a lot of formatting 
options that you have at your disposal when working with them. When a cell containing a Sparkline 
is selected a Design tab for Sparklines will appear in the Ribbon as shown. 

 

The Design tab for Sparklines allows you to change the type of Sparkline in a cell, to change 
formatting options for it such as style and colouring, and to show various high point, low points and 
the like. There is also a command here to clear Sparklines from the cell.  
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CREATING SPARKLINES 
 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise 

you MUST open the file 
E821 Sparklines_1.xlsx... 

 Select the range C4 to E4 

 Click on the Insert tab of 
the Ribbon and click on 
Column in the Sparklines 
group to display the Create 
Sparklines dialog box 

The box shows the data 
range but requires a 
location for the Sparkline… 

 Click in cell G4 in the 
worksheet, then click on 
[OK] to create the 
Sparkline 

 Select the range C5 to E5 

 Click on Line in the 
Sparklines group to 
display the Create 
Sparklines dialog box 

 Click in cell G4 in the 
worksheet, then click on 
[OK] 

 Repeat the above steps 
and create a Win/Loss 
Sparkline in G6 for the 
range C6 to E6. 

 

For Your Reference… 

To create a Sparkline: 

1. Select the range for the data series 

2. Click on the Insert tab and click on a 
Sparkline type in the Sparklines group 

3. Click in the location cell and click on [OK] 

Handy to Know… 

 In our worksheet example we have increased 
the row height for rows where Sparklines 
will be inserted. This helps us to better spot 
the up and down trends in Sparklines. 
Unfortunately it makes the worksheet data 
look a bit odd. 

 

1 

2 

Sparklines are created from the Insert tab on 
the Ribbon. You have the choice of creating a 
Line, Column or Win/Loss Sparkline from the 
Insert tab. While it is good to get it right at this 

stage you do have the option of changing the type 
of Sparkline after it is created. Like other forms of 
charting you will need to select the data series 
before creating the Sparkline. 

3 

7 
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EDITING SPARKLINES 
 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or 
open the file E821 
Sparklines_2.xlsx... 

 Click in cell G4 and click on 
the Design tab that has 
appeared on the Ribbon 

 Click on Sparkline Colour to 
see a palette of colours and 
click on Olive Green to 
change the Sparkline 
colours 

 Click on High Point to tick it 
and display the highest value 
in the Sparkline in a different 
colour 

 Click on Low Point to colour 
the lowest point differently 

 Click on Line to change the 
Sparkline type from a 
column to a line 

 Click on cell G5 which has 
the second Sparkline and 
click on Clear on the Design 
tab to remove it 

 Click on cell G6 which 
contains a Win/Loss 
Sparkline and drag the fill 
handle down to G10 to 
create more Sparklines 

 

For Your Reference… 

To edit a Sparkline: 

1. Click on the cell or range containing the 
Sparkline(s) 

2. Use the commands on the Design tab to 
make the appropriate changes 

Handy to Know… 

 You can actually edit multiple Sparklines by 
selecting the cells in which they are located 
as a range. 

 You can place a Sparkline in a cell 
containing data – the data and the Sparkline 
will appear together (but it will look a bit 
crowded) 

 

4 

6 

Sparklines in Excel 2010 are both easy to 
create and easy to edit. When a cell containing a 
Sparkline is selected a Design tab for 
Sparklines will appear on the Ribbon. The 

Design tab allows you to change the type of 
Sparkline in the cell, its formatting and colouring, 
and to specify things such as high and low points. 
You can also fill Sparklines to adjacent cells. 

7 
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NOTES: 
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